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1 Preparing to install Kodak Matchprint Inkjet proofers
The installation procedure for the Kodak Matchprint Inkjet proofing solution includes software,
hardware, color management, and networking instructions.

Before unpacking and installing the proofer, you must:

1. Check that you have all the service tools, equipment, and documentation that you will need for
the installation.

2. Complete preparation steps as described in the site preparation document for the proofer that
you’re installing.

WARNING: Failure to follow the preparations described in this section could result in serious
damage to equipment or cause complications during installation.

1.1 Field engineer components
Ensure that you have all the field service tools, equipment, and documentation that you will need
for the installation. Field service engineer components include:

● A software license key (This document describes how to obtain a license key.)
● The latest source profiles and media configuration files for the media that the customer site will

use. For the latest files, go to the Kodak eCentral portal at https://ecentral.kodak.com/.

Before you leave the site, use the Matchprint Inkjet Installation Statement of Work, available on
TechPlanet, to complete the installation.

1.2 Related documents
Ensure that you have the following documents:

● The user manual shipped with the printer
● Connectivity documents for the workflow software, such as Kodak Prinergy, Kodak Prinergy Evo,

or Kodak Brisque.
You can find the connectivity documents on the resource disc for the proofer or on the
TechPlanet support Web portal (http://techplanet.creo.com/). Click Proofing > Proofer
Software > Kodak Proofing Software. Select the desired version of Kodak Proofing Software, and
click the Connectivity link.

● Kodak Help that is installed with Kodak Proofing Software

Note: In Proofer Administrator, select Help > Help Topics to display the Kodak Proofing
Software Help.

● The Matchprint Inkjet Site Preparation document, available on the proofer’s Installation page on
TechPlanet

● The Matchprint Inkjet Installation Statement of Work document, available on the proofer’s
Installation page on TechPlanet

● The Kodak ColorFlow Software Implementation Guide document
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1.3 Components shipped by Kodak
Ensure that you have the following hardware and software components.

Hardware:

● Dell computer and monitor
● Power cables (used to connect the printer and Proofer Controller)
● Keyboard
● Mouse
● Label printer (if the customer ordered the Kodak Certified Process for Color Confirmation

option)
● Spectrophotometer (if the customer ordered one from Kodak)

Software:

● Kodak Proofing Software for Matchprint Inkjet Clone disc for each model of Dell computer used
● Kodak Proofing Software for Matchprint Inkjet Software Installation Disc
● Kodak Proofing Software Resource disc
● USB dongle

The customer is responsible for providing an Ethernet (straight through) cable or a USB cable to
connect the printer. The Ethernet cable is for a network connection, and the USB cable is for a USB
connection.

1.4 Inspecting the contents of the printer box
Inspect the device box and pallet.

1. Look for signs of damage caused by moisture, improper packing, tipping, dropping, stacking, or
mishandling.

2. Record problems and report them immediately to Kodak and the delivery company.

2 Chapter 1—Preparing to install Kodak Matchprint Inkjet proofers
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2 Installing the Proofer Controller clone

Tip: Unpack the software package and Proofer Controller first. Start installing the proofing software
clone. While the installation takes place, you can continue to unpack and set up the printer
hardware.

2.1 Setting the voltage on the Dell Optiplex
You must correctly set the voltage switch on the Proofer Controller before you plug in the
computer.

DANGER: The Dell Optiplex Proofer Controller does not automatically switch voltage. You must set
the correct voltage before you plug it in. At the back of the Proofer Controller, remove the Check
Voltage sticker and ensure that the voltage is set correctly before plugging in the Proofer Controller.

Before plugging in the Proofer Controller, ensure that the voltage switch on the Proofer
Controller is set at the voltage that is appropriate for your region.

Figure 1: Check voltage sticker

2.2 Installing the monitor, keyboard, and mouse
1. Connect the monitor, keyboard, and mouse to the Proofer Controller.
2. Turn on the monitor.

2.3 Installing the clone on the Proofer Controller
Requirements:
● Kodak Proofing Software for Matchprint Inkjet Clone disc for the Proofer Controller model that

you are using. (Each Proofer Controller model uses a different clone disc.)

1. Use the power cable to connect the Proofer Controller to the wall outlet.

719-00521F-EN-B-PR01 Kodak Confidential
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2. Access the Proofer Controller’s BIOS:

a. Turn on (or restart) the Proofer Controller.
b. When the Dell logo appears, press the F2 key and hold it down for five seconds.

If you see the Microsoft Windows logo, you did not press F2 in time. Wait until you see the
Windows desktop, and restart the computer again.

3. Depending on your Proofer Controller model, select one of the following procedures to change
the boot sequence on the Proofer Controller, insert the Kodak Proofing Software for Matchprint
Inkjet Clone disc into the DVD-ROM drive, and install the clone software.

For this model Do this

Dell Optiplex 755 1. In the System Branch node, use the up and
down arrow keys on the keyboard to
highlight Boot Sequence, and press the
Enter key.

2. Use the up and down arrow keys to select
Onboard or USB CD-ROM Drive.

3. Use the letter U key to move Onboard or
USB CD-ROM Drive to the number one
position on the list.

4. Press Enter to save your changes.
5. Insert the KPS clone disc into the DVD-

ROM drive.
6. Press the Esc key.
7. Select Save and Exit, and press Enter.

Dell Optiplex 960 1. In the System Branch node, use the up and
down arrow keys on the keyboard to
highlight Boot Sequence, and press the
Tab key.

2. Press the right arrow key once.
3. Use the up and down arrow keys to select

Onboard or USB CD-ROM Drive.
4. Press the Page Up key multiple times until

the Onboard or USB CD-ROM Drive is at
the top of the list.

5. Insert the KPS clone disc into the DVD-
ROM drive.

6. Press the Esc key. This opens a Warning
window that asks if you want to save your
changes.

7. Click Yes to save changes.

When the installation starts, the Proofer Controller plays a three-tone sound. The installation
process takes up to 30 minutes.

4 Chapter 2—Installing the Proofer Controller clone
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Note: If you do not hear the three-tone sound, check that the Proofer Controller is starting up
from the disc.

4. While you are waiting for the installation to finish, assemble the proofer.
When the clone software installation completes, the Proofer Controller plays a sound.

5. Remove the disc from the DVD-ROM drive before restarting the system.
This prevents the system from installing the clone software again.

Installing the clone on the Proofer Controller 5
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3 Setting up Kodak Matchprint Inkjet proofers

3.1 Setting up Epson Stylus Pro printers
1. Assemble and set up the printer hardware, using the instructions in the user guide for the

printer model.
2. If you are installing the Epson Stylus Pro 7900, 7890, WT7900, 9900, 9890, or 4900 proofer,

perform the following tasks:

a. On the printer’s front panel, go to Menu > Printer Setup > Platen Gap, and confirm that
Platen Gap is set to Standard.
The Standard setting allows Kodak media configuration files to adjust the platen gap as
needed.

b. If the customer most often uses the printer for imposition proofs, turn off the Auto Nozzle
Check on the printer’s front panel.

c. If you are installing an Epson Stylus SpectroProofer (also known as an inline
spectrophotometer), perform the following actions:
● Install the white backing, not the black backing.
● On the printer’s front panel, select Menu > Paper Setup > Paper Type > Proofing Paper,

and then select Proofing Paper W SM.
● Align the SpectroProofer. See Aligning the inline spectrophotometer for Epson Stylus Pro

x900, and x890 printers on page 8.

3. Apply the Kodak logo decal (part number 382-01339x where x is the latest version) on the front
of the printer. Make sure the label is straight.

Figure 2: Epson Stylus Pro 48xx

Figure 3: Epson Stylus Pro 78xx
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3.2 Aligning the inline spectrophotometer for Epson Stylus Pro
x900, and x890 printers
Spectrophotometer alignment is required for accurate measurements of charts for the calibration
process and for the media configuration creation process, as well as the measurement of color bars
for the Certified Process for Color Confirmation.

Align the inline spectrophotometer when you change media or when you load a new role of media.
If you change the spectrophotometer and filter, you must restart the proofer to inform Kodak
Proofing Software of the changed spectrophotometer and filter.

1. Go to the front panel on the Epson Stylus Pro x900 printer.
2. From the menu, select Options Setup.
3. Select Spectro Proofer.
4. Select Device Alignment.
5. Select Execute.
6. Select OK.

3.3 Setting up Epson Stylus Pro printers to read the sheet
position
Requirements:
● Only Epson Stylus Pro 7700, 7900, 9700, 7890, 9890 and 9900 printers support this feature,

and the printer must be connected by a network to Kodak Proofing Software. A USB connection
does not support this feature.

Note: If you encounter Kodak Proofing Software error numbers 6077 or 6078 about the software's
inability to read the sheet position, you may need to upgrade the firmware before you can set up
the feature. Use the EPSON LFP Remote Panel or the EpsonNet Config Utility to upgrade the
firmware to the latest version. For the EPSON LFP Remote Panel and the EpsonNet Config Utility,
go to the Epson Web site (http://www.epson.com/). Only older Epson Stylus Pro printers may
require firmware updates. Newer models should have the necessary firmware.

The firmware requires specific settings to enable the printer to read the sheet position for double-
sided proofs. When using a layout that is configured for double-sided printing, Kodak Proofing
Software can use the sheet position to understand the angle of the loaded sheet and to
automatically rotate the proof image to match the angle of the sheet. In other words, Kodak
Proofing Software can rotate the proof image to center the image horizontally and to position the
image parallel to the leading edge. When you view the printed proof, the proof image is square in
relation to the sheet edges.

You only need to perform this procedure once.

1. Turn off the printer.
2. Press and hold the Pause button while turning on power to the printer.
3. Continue holding the Pause button, and watch the front panel.
4. When Maintenance Mode appears on the front panel, release the Pause button.

8 Chapter 3—Setting up Kodak Matchprint Inkjet proofers
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5. Press the down arrow button to locate and select Custom.
6. Press the up arrow button or the down arrow button to locate and select 2.

The 0 setting indicates that the feature is turned off.
7. Press OK, and then press the left arrow button until you return to the main menu.
8. Turn off the printer.
9. Turn on the printer.

3.4 Installing printer drivers
Install the printer driver for the Matchprint Inkjet proofer before you install the client and server
software. The software installation uses information that is in the driver.

1. Install the printer driver following the installation instructions that are provided by the printer
manufacturer.

2. If you use an Epson Stylus Pro x600 or x800 printer through USB, perform these actions:

a. Go to the Epson Web site and download the status monitor that is specifically for the
operating system on your computer.

b. Install the status monitor (after you install the printer driver).

Installing printer drivers 9
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4 Installing ColorFlow software
Kodak ColorFlow software is optional. Install ColorFlow software on the Proofer Controller, if the
customer purchased the software.

Requirements:
● Installation disc for ColorFlow software

ColorFlow software uses the license dongle for Kodak Proofing Software.

Install ColorFlow software on drive D of the Proofer Controller.
For details, see the ColorFlow Software Configured for Kodak Proofing Software Implementation
Guide.
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5 Installing Kodak Proofing Software
It is important to install the Kodak Proofing Software before you add the Proofer Controller to a
network domain. When you add the Proofer Controller to a network domain before you install
Kodak Proofing Software, network permission issues may occur.

Use this section to install both the proofer server and client software on the Proofer Controller. On
a Mac computer, you can install the client software, but not the server software.

5.1 Installing the Kodak proofer client and proofer server
software
Requirements:
● The printer driver must be installed.
● Locate the Kodak Proofing Software for Matchprint Inkjet Software Disc.
● Find out the Kodak service user name and password, for access to the Proofer Controller.

If the site wants to add the Proofer Controller to a network domain, install the Kodak proofer server
and proofer client software on a Proofer Controller before you add the Proofer Controller to a
network domain. Do not add the Proofer Controller to the network domain, and then install the
Kodak proofer server and proofer client software; it may cause network permission problems.

Note: Do not install the server software to a network drive. Network drives are not supported.

1. On the Proofer Controller, use the Kodak service user name and password to log in.
2. When prompted, insert the software disc into the drive.

Note: The install can be cancelled at this point to create a custom proofer controller name. See 
Changing the Proofer Controller name on page 14

3. Press OK to begin the installation.
The installation process begins automatically. The installer program installs both the client and
server software on the Proofer Controller. As a result, the complete installation may take up to
20 minutes.

4. Follow the on-screen prompts.
Adobe Reader is required to run reports. If Adobe Reader 8.x or higher software is not already
installed on the workstation, select the option that opens the Adobe Web site when the
installation is completed. Or, you can go to the Adobe Web site and download the software
after the installation.

5. Remove the disc from the drive when the installation is complete.
6. Restart the Proofer Controller.

Important: Be sure to start the Proofer Controller after the software is installed, even if the
installer says that this is not necessary.

719-00521F-EN-B-PR01 Kodak Confidential
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5.2 Changing the Proofer Controller name
Each Proofer Controller is given a generic name in the form “CX<xxxx,>” where <xxxx> is a number.
The customer can choose to continue using this name, or change it to a more appropriate one.

Note: Changing the Proofer Controller name after registering the RSS client software 2.1 causes the
RSS software client to lose its registration.

1. On the Proofer Controller, use the Kodak service user name and password to log in.
2. On the desktop, right-click My Computer, and click Properties.
3. On the Computer Name tab, click Change.
4. In the Computer Name box, type the new name, and click OK.
5. Click OK to close the System Properties window.
6. Restart the Proofer Controller.

5.3 Kodak proofer client software installation on workstations
After installing the client software on the Proofer Controller, you can install it on additional
computer workstations.

You can install the software from the Proofer Controller. Alternately, if you have the version of the
client software on a field service engineer laptop computer, you can open and install the client
software from the laptop.

5.3.1 Installing proofer client software (Windows)

You can access the Proofer Controller from a Windows-based computer to install the proofer
client software.

Note: When you start the client software software on a Windows 7 operating system, the Program
Compatability Assistant dialog box may appear. Click This program installed correctly to clear the
error and keep it from appearing again.

1. From the Start menu, select Run.
2. In the Open box, type \\<ControllerName> or \\proofers\<ControllerName>, and click

OK.

Note: <ControllerName> is the name of the Proofer Controller, as shown in Proofer Finder.
You may need to include the domain name (proofers) before <ControllerName>.

3. If the Connect to dialog box appears, in the User Name box and Password box, type proofer,
and click OK.

4. Double-click ProofClient.
5. When the proofclient directory appears, locate the Windows directory, and double-click

setup.exe.
6. Follow the on-screen prompts.
7. Make sure Adobe Reader 8.x or later is installed on the workstation.

Note: Remember to make Adobe Reader the default PDF viewer.

14 Chapter 5—Installing Kodak Proofing Software
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5.3.2 Installing proofer client software (Mac OS)

Access the Proofer Controller from a Mac computer and install the proofer client software.

Requirements:
● You need the administrator password.

1. From the Finder menu, choose Go > Connect To Server.
2. In the Address box, type smb://<ControllerName>/proofclient, and click Connect.

Note: <ControllerName> is the name of the Proofer Controller, as shown in Proofer Finder.
You may need to include the domain name (proofers) before <ControllerName>.

3. If the Connect to dialog box appears, in the User Name box and Password box, type proofer,
and click OK.

4. When the proofclient directory appears, locate the Mac directory, and double-click setup.

5. Follow the on-screen prompts.
If you are installing on a Mac workstation, the installer prompts you to install the Keyspan Mac
OS X Adapter drivers.
You need Keyspan drivers only if you plan to use a serial cable to connect a spectrophotometer
to a Mac workstation. You do not need Keyspan drivers if your spectrophotometer uses a USB
connection, if you use an inline spectrophotometer, or if you are not planning to connect a
spectrophotometer on this computer.
After restarting, you must enable the adapter drivers.

6. Make sure Adobe Reader 8.x or later is installed on the workstation.

Note: Remember to make Adobe Reader the default PDF viewer.

5.4 Making Adobe Reader the default PDF viewer (for Mac
workstations)
If you are using a Mac workstation, you must make Adobe Reader the system’s default PDF viewer.

1. Select a PDF file.
2. In the Finder, select File > Get Info.
3. From the Open with menu, select Adobe Reader.
4. Click Change All to make Adobe Reader the default PDF viewer software.
5. Close the Get Info window.

5.5 Turning off sleep mode (for Mac workstations)
Mac workstations must not be allowed to enter sleep mode because the sleep mode disconnects
network communication. When the workstation wakes up, it displays a disconnected or offline
error.

1. On the Dock, click System Preferences.
2. Click Energy Saver.
3. Set both the computer and display to Never sleep.

Installing proofer client software (Mac OS) 15
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4. Close System Preferences.

5.6 Enabling East Asian language support (for Windows XP)
Kodak Proofing Software allows you to operate the software in an East Asian language, such as
Japanese, using an English Microsoft Windows XP operating system.

Microsoft Windows Vista and Windows 7 operating systems include support for East Asian
languages.

1. Install the East Asian language files.
The customer needs to provide the original Windows operating system installation disc to
complete the installation. For more information, go to the Microsoft Web site.

2. In the Regional and Language Options window on the Advanced tab, select the East Asian
language that is used for non-Unicode programs.

Note: You must enable East Asian Language support on the Proofer Controller and any
additional client workstations.

5.7 Setting the firewall for the Color Database Editor (for
Windows 7 workstations)
When proofer client software runs on a Windows 7 operating system, you must set a firewall
setting to allow the Color Database Editor to open. You must set the firewall setting every time
that you upgrade or install Kodak Proofing Software.

Requirements:
● Administrator privileges for Windows 7

Note: When you first start the proofer client software on a workstation that is running the
Windows 7 operating system, a warning message appears asking whether you want to let the
javaaw.exe file access the network. Click Allow. You may also see the Program Compatibility
Assistant dialog box. Click This program installed correctly to clear the error and keep it from
appearing again.

1. In Windows 7, click the Start button, and select Control Panel.
2. Click System and Security.
3. Click Windows Firewall > Advanced Settings.
4. In the left panel, click Inbound Rules.
5. In the Action column, click New Rule.

The New Inbound Rule wizard appears.
6. Select Program, and click Next.
7. Select This program path:, and click Browse.
8. Select Program Files\Kodak\Proofer Client <version>

\OpenConnectivityClient.exe, click Open, and click Next.

9. Select Allow the connection, and click Next.
10. Select Domain, Private, Public, and click Next.

16 Chapter 5—Installing Kodak Proofing Software
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11. In the Name box, type KPS Open Connectivity Kit, and click Finish.

You can now open the Color Database Editor in the Windows 7 operating system.

Setting the firewall for the Color Database Editor (for Windows 7 workstations) 17
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6 Configuring the Proofer Controller

6.1 Proofer Controller network settings
You can connect the Proofer Controller to the network using one of the following methods:

● Static DHCP
● Static IP
● DHCP

Note: If you are installing an Epson Stylus Pro 10600 proofer to the network, you must connect this
model to the onboard network card and not the secondary network card. With computers that use
Windows operating systems, disable the secondary network card so that only the primary onboard
network card is used.

Static DHCP
Static DHCP is the recommended method—provided the site uses a DHCP server that supports
static DHCP. Static DHCP uses a DHCP server to assign a static IP address based on the unique
MAC (Media Access Control) address of the Controller’s network card. This method combines the
advantages of static IP and DHCP, because workflow systems see a static IP address while still
allowing for simple network management from a central location.

The site must have a DHCP server that supports static DHCP. Work with the site’s network
administrator to map the Controller’s MAC address to a static IP address, subnet mask, and default
gateway.

Note: If you reinstall the Controller software, you need to remap the Controller’s MAC address to the static IP
address.

Static IP
For static IP, you must obtain a static IP address, subnet mask, and default gateway from the site’s
network administrator. Some workflow systems, such as Brisque, do not support DHCP and must
use static IP.

DHCP
DHCP is easier to set up and manage because each time that the Controller connects to the
network, it requests a new IP address. You cannot use DHCP if the workflow system does not
support DHCP, or if the site does not have a DHCP server. The Brisque software does not support
DHCP.

If the site’s network does not use DHCP, use the field service engineer laptop and a crossover cable
to connect to the system.

6.2 Configuring sites with DHCP or with static DHCP
By default, the Proofer Controller uses DHCP to automatically obtain its network settings. Because
of this, you don’t need to change its network settings when you first install the Controller unit.
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6.2.1 Finding the Proofer Controller's IP address

1. Open Proofer Administrator.
If the Proofer Controller does not appear in Proofer Finder, open Proofer Administrator by
name. In Proofer Finder, from the Controller menu, select Administer by Name, and type the
computer name.

2. Click the Controller icon, and click the Settings tab to see the IP address.

6.2.2 Configuring static DHCP

If the site’s DHCP server supports static DHCP, work with the network administrator to map the
Controller’s MAC address to a static IP address, subnet mask, and default gateway.

1. Using the monitor connected to the Proofer Controller, log on to Windows using the username
prooferAdmin and the password prooferAdmin (case sensitive).

2. Click the Start menu, click Run, type cmd, and click OK.

3. In the Command window, type ipconfig /all, and then press Enter.

4. Write down the MAC address.
This is the physical address of the network card.

5. Work with the network administrator to map the Proofer Controller’s physical address to a
static IP address on the site’s network.

6.3 Configuring sites without DHCP
The Proofer Controller ships in DHCP mode. If the network at the site is not running a DHCP
server, the Proofer Controller and proofer client will be unable to connect. To resolve this, change
the Proofer Controller to use a static IP address.

Requirements:
● Network settings from the site’s network administrator—static IP address, subnet mask, and

default gateway

The Proofer Controller ships in DHCP mode. If the site’s network is not running a DHCP server
when the Proofer Controller is connected to the network, it emits a tone followed by the audible
voice message—Warning: No DHCP server detected. It repeats this message every 10
seconds until its network connection status changes, or the unit is turned off. The Proofer
Controller also falls back into Automatic IP mode, taking an IP address in the 169.254.<x>.<x>
range.

In this situation, because the Proofer Controller cannot obtain an IP address automatically, the
proofer client cannot find it on the network. Therefore, for sites that do not use DHCP, you must
change the Proofer Controller to use a static IP address.

1. On the Proofer Controller, log on to Windows using the username prooferAdmin and the
password prooferAdmin (case sensitive).

2. On the Proofer Controller desktop, right-click My Network Places, and select Properties.
3. Right-click Local Area Connection, and select Properties.
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4. Click Internet Protocol (TCP/IP), and click Properties.
5. Select Use the following IP Address.

a. In the IP address, Subnet Mask, and Default Gateway boxes, type the numbers provided by
the network administrator.

b. Double-check the IP address, Subnet Mask, and Default Gateway values. Make sure these
values are correct and are entered correctly. If the values are incorrect, you will not be able
to see the Proofer Controller on the network.

c. Click OK.
d. Click Close to exit the Local Area Connection Properties window.

6. To confirm that the network settings have taken effect, start the Kodak proofer client software.
If Proofer Finder shows the proofer name, the settings have taken effect.

6.4 Opening Proofer Administrator

6.4.1 Opening Proofer Administrator

1. In Proofer Finder, in the Proofer list, select a proofer.
2. From the Controller menu, select Administer. Alternately, you can press the Ctrl key and

double-click a proofer to display the password dialog box.
3. When prompted for the password, type prooferAdmin, and click OK.

If someone else has Proofer Administrator open, the system prompts you to send a message requesting to
“obtain the lock,” which—if the person at the other workstation agrees—allows you to open Proofer
Administrator. If the other workstation does not respond within 15 seconds, Proofer Administrator opens.

6.4.2 Opening Proofer Administrator by IP address or logical name

If the client software and proofer are on different subnets, the proofer name may not appear in
Proofer Finder. In this case, you can open Proofer Administrator using the Proofer Controller’s IP
address or logical name.

Note: Depending on how your network is set up, you may have to open the window with its IP
address.

1. In Proofer Finder, from the Controller menu, select Administer by Name.
2. In the Type the Name or IP Address of the Controller box, type the IP address or name of the

Proofer Controller that you want to connect to.
3. Click OK.
4. When prompted for the password, type prooferAdmin, and click OK.

If someone else has Proofer Administrator open, the system prompts you to send a message requesting to
“obtain the lock,” which—if the person at the other workstation agrees—allows you to open Proofer
Administrator. If the other workstation does not respond within 15 seconds, Proofer Administrator opens.
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6.5 Adding a license key
Before you can add the proofer to the Proofer Controller, you must add a license key.

6.5.1 Installing the dongle

Requirements:
● A license dongle

1. Plug the dongle into a USB port in the Proofer Controller.
2. Open Proofer Administrator.
3. Click the Proofer icon, and click the Licenses tab.
4. Click Dongle ID.
5. Write down the dongle ID number.

Depending on how you obtain a license key, you may need this number. You can copy and
paste the dongle ID number.

6.5.2 Using PLAS with the Internet to license

When the Proofer Controller is connected to the Internet, you can use PLAS to obtain and install a
license key.

Obtaining and adding a license key with PLAS and the Internet

Use Proofer Administrator with PLAS and the Internet to retrieve and add a license key to Proofer
Controller.

Requirements:
● The Proofer Controller is connected to the Internet.
● The license key has been purchased from Kodak (if necessary).

You do not need to provide the dongle ID to retrieve the license key. PLAS (Product License
Activation System) automatically detects the dongle ID and replaces the existing license.

1. Open Proofer Administrator.
2. In Proofer Administrator, click the Controller icon, and click the License tab.
3. Click Get License.

Wait for a connection to be established with PLAS.
4. Select the Register Product / Retrieve License check box, and click Next.
5. Select the Automatic license retrieval check box, and click Next.

6.5.3 Using PLAS to manually add a license key

You can obtain a license key without using PLAS, and use PLAS to manually add the license key.
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Obtaining a license key from the License Key Generator

Requirements:
● Access to the Kodak License Key Generator intranet Web site
● Dongle ID

1. Go to the Kodak License Key Generator intranet Web site at http://
productregistration.kodak.com/SearchKeys.aspx.

2. Select Permanent License.
3. In Dongle ID/Computer ID, type the dongle ID to search for the license key.
4. In Product, click Proofing Software, and select Kodak Proofing Software - Matchprint.
5. Click Search.
6. In the results list, locate the customer name and the corresponding dongle ID. Click the license

hyperlink.
7. Scroll down to the bottom of the window, and enter an e-mail address to which you can send

and receive the license key file at the customer site, and click Send Email.
8. When you have the new license key file, save the file where this computer can access it.

Note: Save the license in text format, not RTF (rich text format).

Adding a license key with PLAS

Requirements:
● A license key in text format

1. Open Proofer Administrator.
2. In Proofer Administrator, click the Controller icon, and click the License tab.
3. Click Get License.

Wait for a connection to be established with PLAS.
4. Select the Load license key from a file check box, and click Next.
5. Click Browse, locate and select the license key, and click Upload.

After the Proofer Controller restarts, the licensed features will be available.

6.5.4 Using Kodak eCentral to license

When the Proofer Controller is connected to the Internet, the PLAS licensing server can be
accessed using Kodak eCentral.

Obtain a license from Kodak eCentral

A license can be obtained by accessing PLAS using your Kodak eCentral account.

Requirements: Internet Access, Kodak eCentral Account

1. Go to Kodak eCentral portal at https://ecentral.kodak.com/
2. From the home page click Self Support.
3. Click Product Registration and Self-Support.
4. Click Register products.
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5. Enter your Kodak Proofing Software dongle id.
Your dongle id must be entered in two places:
● Product serial number
● Dongle ID or computer ID

A list of products registered to your dongle id appear.
6. Select Kodak Proofing Software - Matchprint v5.1.

7. Select Downdload the license key.
8. Download the xml file and install in Kodak Proofing Software.

6.6 Connecting an Epson Stylus Pro printer
Requirements:
● The software must be licensed.
● The printer driver must be installed.

Note: If you want to use the Epson Stylus Pro 7700, 9700, 7900, WT7900, 7890, 9890 or 9900
printer for double-sided printing, and you want to use the printer's firmware feature to
automatically read the sheet position, you must connect the printer via a network to Kodak
Proofing Software. A USB connection does not support this feature. You must also configure the
firmware. For more information, see the Matchprint Inkjet and Kodak Proofing Software Double-Sided
Media Guide Installation Guide for your proofer model.

1. Perform one of the following actions:

For this connection Do this

USB connection 1. Insert the proofer’s USB cable into the
Proofer Controller.

2. Use the monitor to view the Proofer
Controller desktop. If the Windows
operating system displays the Add Printer
wizard, click Next and follow the on-
screen prompts in the Add Proofer wizard
to add a proofer.

3. Go to step 4.

Network connection Connect the proofer to the network. The
printer must be on the same subnet as the
Proofer Controller.

2. In the Proofer Administrator, click the Controller icon, and click the Proofers tab.
3. Click New and follow the on-screen prompts in the Add Proofer wizard to add a proofer.

After adding a proofer, the Proofer Controller restarts automatically.
4. On the Proofers tab, select the proofer and click Enable.
5. On the Software tab, make sure the software running the proofer is running. If the status

indicates the software is stopped, click Restart to start the software.
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7 Setting up spectrophotometers

7.1 Enabling the Keyspan adapter drivers (for Mac
workstations)
Keyspan adaptor drivers are needed only if you plan to run a spectrophotometer on this system
through a serial cable that is connected to a Mac workstation. Keyspan adaptor drivers are not
needed if your spectrophotometer uses a USB connection, or if you use an inline
spectrophotometer.

If you installed the Keyspan adapter drivers on your Mac workstation, enable the serial ports for the
Keyspan adapter drivers.

Note: The USA 28X model does not work with the Intel-based Mac computer.

1. From the Apple menu, click System Preferences.
2. Click Network.
3. In the Network window, from the Show list, select Network Port Configurations.
4. Ensure that the USA19H81P1, USA28X2P1, and USA28X2P2 ports are selected.
5. If you made any changes, click Apply Now, and then quit System Preferences.

7.2 Installing the driver for offline spectrophotometers (new
spectros only)
Install the driver before you connect the offline spectrophotometer. Spectrophotometers are used
to calibrate the proofer, create custom media configurations, and measure color bars for the
Certified Process for Color Confirmation.

Follow the wizard instructions to install the driver from the disc that is provided with the
spectrophotometer. Install the driver on the computer to which you will connect the
spectrophotometer.
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8 Setting up label printers

8.1 Label printers
The Dymo LabelWriter is the device that prints the labels that are required for the Certified Process
for Color Confirmation.

The system currently supports the Dymo Labelwriter 400 and 450 using a USB connection and the
following label sizes:

● 14 mm × 89 mm (9/16 in. × 3.5 in.)
● For the backside of the media (if using double-sided media), 28 mm × 89 mm (1 1/8 in. × 3.5 in.)

To order more labels, contact the Dymo dealer in your area (http://www.dymo.com).

Note: Epson Stylus Pro 4900, 7900, WT7900, 7890, 9890 and 9900 printers with inline
spectrophotometers can automatically print label content on the proof. With these printers, you do
not need to use the label printer to print labels. Use the layout to specify whether you want the
Epson Stylus Pro printer or the label printer to print labels.

8.2 Installing label printers for offline spectrophotometers
When you use an offline spectrophotometer to measure color bars for the Certified Process for
Color Confirmation, you can connect the label printer to either the Proofer Controller or the client
workstation. Use the hardware that is closest to where you measure color bars, and use Proofer
Administrator to identify where you connected the label printer.

1. Follow the wizard instructions to install the printer driver from the disc that is provided with the
Dymo Labelwriter. Install the printer driver on the computer to which you will connect the
Dymo Labelwriter.

2. Use the power cord to connect the label printer to the main power supply.
3. Use the USB cable to connect the label printer to the Proofer Controller or the client

workstation, where you will measure color bars.
4. Open Proofer Administrator.
5. Click the Proofer icon, and click the Settings tab.
6. In the Label Type list, select the type of label printer you are using.
7. In the LabelWriter connected to list, identify where you connected the label printer.
8. Click Apply.

For more information, see the documentation provided with the label printer.

8.3 Installing label printers for inline spectrophotometers
When you use a printer with an inline spectrophotometer to measure color bars for the Certified
Process for Color Confirmation, connect the label printer to the Proofer Controller.

Note: Epson Stylus Pro 4900, 7900, WT7900, 7890, 9890 and 9900 printers with inline
spectrophotometers can automatically print label content on the proof. With these printers, you do
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not need to use the label printer to print labels. Use the layout to specify whether you want the
Epson Stylus Pro printer or the label printer to print labels.

1. Follow the wizard instructions to install the printer driver from the disc that is provided with the
Dymo Labelwriter. Install the printer driver on the computer to which you will connect the
Dymo Labelwriter.

2. Use the power cord to connect the label printer to the main power supply.
3. Use the USB cable to connect the label printer to the Proofer Controller or the client

workstation, where you will measure color bars.
4. Open Proofer Administrator.
5. Click the Proofer icon, and click the Settings tab.
6. In the Label Type list, select the type of label printer you are using.
7. In the LabelWriter connected to list, identify where you connected the label printer.
8. Click Apply.

For more information, see the documentation provided with the label printer.
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9 Setting up Kodak Proofing Software

9.1 Downloading configuration files from eCentral
ICC profiles, ICC device link profiles, and media configurations for Matchprint Inkjet proofers are
posted on the eCentral portal.

ICC profile, ICC device link profile, and media configuration downloads are packaged into
configuration files for each proofer model. You can search, download, and install configuration files
by proofer model.

1. Go to eCentral (https://ecentral.kodak.com/).
2. At the top of the navigation bar, click Self Support, and then click Downloads.
3. In the Product list, select Matchprint Inkjet.
4. In the Download Type list, select Configuration files, and click Go.
5. Click the proofer model, and locate the configuration file for the media that you want to use.

Ensure that the media configuration file is compatible with your version of Kodak Proofing
Software.

6. Click the configuration file to download it. If necessary, enter your Kodak user name and
password.

7. Save the configuration file to your desktop.

9.2 Installing configuration files
Install configuration files in Kodak Proofing Software to add new files to your system or to update
your system with the latest files.

Do not manually extract and install the configuration files. You must use the following procedure to
install them. Each time you add a new proofer to the system, you must reinstall the configuration
files because they are excluded from the default settings.

1. In Proofer Administrator, click the Controller icon, and click the Software tab.
2. Click Install.
3. Locate the configuration file, select it, click Open, and then click Install.

When the installation is complete, the installer displays a message that indicates the files were
installed successfully.

9.3 Opening Proofer Viewer
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9.3.1 Opening Proofer Viewer

From Proofer Finder, you can open Proofer Viewer for any proofer (or multiple Proofer Viewer
windows for the same proofer, if desired).

In Proofer Finder, double-click a proofer in the Proofer column.

9.3.2 Opening Proofer Viewer by IP address or logical name

If the client software and proofer are on different subnets, the proofer name may not appear in
Proofer Finder. In this case, you can open Proofer Viewer using the Controller's IP address or
logical name.

Note: Depending on how your network is set up, you may have to open the window with its IP
address.

1. In Proofer Finder, from the Proofer menu, select Open by Name.
2. In the Type the name or IP address of the controller to which the proofer is connected box, type

the name or IP address of the controller to which the proofer is connected, and click OK.
3. When two or more proofers are connected to the Proofer Controller, select the proofer that you

want to view. Select the proofer for which you want to open Proofer Viewer, and click OK.

Proofer Viewer opens.

9.4 Calibrating the proofer

9.4.1 Calibration tips for Epson Stylus Pro printers

Keep the following in mind when calibrating:

● Unless the proofer includes an inline spectrophotometer, connect an offline spectrophotometer
to the client workstation. Both unfiltered and UV-filtered spectrophotometers are supported.

● For the Precision Color Calibration wizard, it is recommended that you use an automated chart
reader, such as the X-Rite i1iO Automated Chart Reader, to reduce the calibration time.

● Before calibrating, print a nozzle check pattern following the instructions in your Epson Printer
Guide, and check that the nozzle check pattern shows no missing dots.

● If you need to adjust the paper feed, see Media Configuration Wizard Paper Feed Adjustment in
the Help.

● The WT7900 printer does not support all spectrophotometers. See the WT7900 Getting
Started Guide for a table of supported spectrophotometers.

9.4.2 Calibrating Matchprint Inkjet proofers

For best results, calibrate the Matchprint Inkjet proofer for the media configuration. You must
calibrate the proofer to be able to use the Certified Process for Color Confirmation.
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The calibration process can take up to an hour or more, and the printer cannot perform any other
function until calibration is complete.

1. In Proofer Viewer, click Calibration.
2. Select the media configuration for the media that is loaded on the proofer.
3. Click Calibrate.
4. Follow the instructions in the Calibration wizard.

9.4.3 Uncalibrated printing

You can use Kodak Proofing Software to print proofs without first calibrating the proofer for the
media configuration. Uncalibrated proofers should not be used for color-critical proofs. However,
some proofs are not color-critical and do not require a calibrated proofer.

Note: The Certified Process for Color Confirmation requires a proofer that is calibrated for the
media configuration that is used to print the proof, and the calibration must be current, not expired.
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10 Configuring input mechanisms
In order to submit files to the printer, you must set up an input mechanism. You can use a workflow
system such as Prinergy or Brisque software to submit files. If you have the Open Connectivity Kit,
you can submit files through one of the workflow systems or through hot folders or virtual printers.

10.1 Input mechanisms for Brisque and Prinergy
Configuring the proofer to accept jobs from workflow software is described in the following
documents:

● Prinergy Workshop and Kodak Proofing Software Connectivity User Guide
● Prinergy Evo and Kodak Proofing Software Connectivity User Guide
● Brisque 5.x and Kodak Proofing Software Connectivity User Guide
● Brisque 4.1 and Kodak Proofing Software Connectivity User Guide

Note: Applications of the Epson Stylus Pro WT7900 printer using white ink can only be used with
Kodak Proofing Software Open Connectivity workflow. Prinergy and Brisque workflow systems will
convert spot white to process.

You can find all of these documents on the Connectivity page of the Kodak Proofing Software Web
site on TechPlanet.

10.2 Using hot folders and virtual printers

10.2.1 Hot folder and virtual printer compatibility

Note: Kodak Proofing Software 5.x and later requires Mac OS X version 10.5 with Sun Java 1.5 or
Mac OS X version 10.6 with Java 1.6 or later. However, you can still submit files to Kodak Proofing
Software from other workstations with different operating systems.

Proofer Controller
operating system

Workstation
operating system*

Hot folder Virtual printer

AppleTalk IP/LPR

Microsoft
Windows XP
operating system

Mac OS X × ×

64-bit Windows ×

32-bit Windows × ×

Microsoft
Windows Server
2003 operating
system

Mac OS X × × ×

64-bit Windows ×

32-bit Windows × ×

× Hot folders or virtual printers are supported.

* Workstation operating system does not necessarily mean the operating system on which the
proofer client software is installed. Rather, it describes the operating system from which you will
submit jobs.
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** Requires a third-party interconnect product

10.2.2 PS/M with PDF2Go

If the site wants to use PS/M with PDF2Go, ensure the site has a PDF2Go license (501R49694,
PS/M PDF2Go Software Module).

● If the site is using Mac OS 9, you need PS/M version 7 and third-party cross-platform file- and
print-sharing software.

● If the site is using Mac OS X, you need PS/M version 8.

When setting up hot folders, on the ICC Settings tab, Input File Color Space area, select Separated
Input. During the refine process, there will be four warning messages about color matching, one
message for each color. You can ignore these warning messages.

For more information about using the ICC Settings tab, see Understanding the ICC Settings Tab in
the Help.

10.2.3 File and folder-naming best practices

When naming input files or folders, do not use any of the following characters.

● Do not use the + - \ / | < > [ ] { } ? . , ! @ # $ % ^ & * ( ) = : ; ' " characters in file names.
● Do not use spaces, including trailing spaces, in your file names.
● Use a period (.) only when using file name extensions—for example, readme.txt.

● Do not use file names longer than 32 characters.

10.2.4 Downloading and installing source profiles

If you are using Kodak Proofing Software with the Open Connectivity Kit and a custom media
configuration, you can access source profiles that are provided by Kodak but that are not included
in Kodak Proofing Software. You may want to use one of the source profiles with your custom
media configuration.

1. Go to eCentral (https://ecentral.kodak.com/).
2. Log on and select Self Support > Downloads.
3. In the Choose a product list, select Kodak Proofing Software.
4. In the Select a download type list, select All, and click Go.
5. Under View only results for, click Source Profiles.
6. Locate the source profile file for your proofer and version of Kodak Proofing Software, and

download it to a location that you can access with Kodak Proofing Software.
7. In Proofer Administrator, on the Software tab, click Install, locate the source profile file, and

click Install.
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10.2.5 Creating hot folders

Creating a hot folder for jobs with CMYK and spot colors

You can create a hot folder for processing jobs that contain CMYK and spot colors and that will be
printed on inkjet proofers. The hot folder uses a specific color library and ICC profile to reproduce
spot colors on proof.

1. In Proofer Viewer, from the Configure menu, select Hot Folders/Virtual Printers.
2. In the Hot Folders/Virtual Printers dialog box, click New.
3. Ensure that the File Input Type is Hot Folder.
4. Set the following options:

a. Select the Media Configuration and Layout options to suit your workflow.
b. In the Halftone Handling list, select None.
c. In the Color Handling list, select CMYK With Spots Press is Final Output.
d. Click Next.

The Process Settings dialog box appears.
5. Click the Spot Colors tab, and select a spot color library.
6. Click the ICC Settings tab, and set the following options:

a. Select Use ICC Profile Color Management.
b. In the Input File Color Space area, click Advanced, and set the options in the Overprinting

Objects area.
c. Select Simulation Color Space, click Advanced, and then select profiles for the color space

that you want the proofer to simulate.
7. Set the remaining options as desired.
8. Click Save.

Next:
Expose the hot folder.

Exposing a hot folder on a Mac workstation

To submit jobs to a hot folder on a Mac OS X workstation, you first must expose the hot folder
(which resides on the Proofer Controller) on that workstation.

Some operating systems cannot communicate with hot folders and virtual printers.

1. On the Mac workstation, from the Finder menu , choose Go > Connect to Server.
2. In the Address box, type smb://<ControllerName>/hotfolders/, where

<ControllerName> is the name of the controller, as shown in Proofer Finder.

Note: If the Proofer Controller computer is on a different subnet, you may need to include the
domain name, which is usually Proofers. If this domain name does not work, contact your
network administrator.

3. Click Continue.
4. If the Connect to <ControllerName> dialog box appears, type proofer in both the User Name

and Password boxes. Click OK.
The Hotfolder directory opens, listing the names of all hot folders configured for that proofer.

Creating hot folders 35

719-00521F-EN-B-PR01 Kodak Confidential



5. Create a shortcut to the required hot folder by dragging it to the desktop.

Exposing a hot folder on a Windows-based workstation

To submit jobs to a hot folder on a Windows-based workstation, you first must expose the hot
folder (which resides on the Proofer Controller) on that workstation.

Some operating systems cannot communicate with hot folders and virtual printers.

1. Open My Network Places and locate the proofer on the network. (Kodak proofers are usually in
the Proofers work group.)

2. If the Connect to <ControllerName> dialog box appears, type proofer in both the User Name
and the Password boxes. Click OK.

3. Locate the HotFolders directory.

4. Right-click the hot folder to which you want to submit jobs, and click Create Shortcut.
5. Drag the shortcut to a convenient location, such as the desktop.

10.2.6 Creating virtual printers

AppleTalk or IP printing (LPR) print driver

Instructs the virtual printer which print driver to use, AppleTalk or IP Printing (LPR). An IP Printing
(LPR) driver processes files faster than an AppleTalk driver. Keep in mind that certain operating
systems cannot connect to an AppleTalk print driver, and some cannot connect to an IP Printing
(LPR) print driver.

Adding a PPD file to a Mac OS X workstation

A Adobe PostScript printer description (PPD) is a file that describes the attributes of a particular
printer type to the submitting workstation. Before you can submit a file via a virtual printer, a PPD
file must be in the appropriate location on that workstation. This needs to be done only once per
workstation.

1. Locate (or create) a PPD file for the type of printer that you are using.
2. On your workstation, locate the //Library/Printers/PPDs/ folder, and create a folder

named Kodak.

Note: The two forward slashes (//) indicate the highest level of the disk (also called “root”).

3. Copy the PPD file to the new folder.

Creating a hot folder or virtual printer

Creating a hot folder or virtual printer has two steps—creating and configuring the hot folder /
virtual printer, and exposing the hot folder or publishing the virtual printer to the workstation that
will be submitting files. You can create as many hot folders or virtual printers as you need.

Some operating systems cannot communicate with hot folders and virtual printers.

1. In Proofer Viewer, from the Configure menu, select Hot Folders/Virtual Printers.
2. Click New.
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3. In the Name box, type a name for the hot folder or virtual printer.

Note: If you plan to publish a virtual printer on a Windows-based workstation, the name cannot
contain spaces.

4. Perform one of the following actions:

To create Do this

A hot folder Select Hot Folder.

A virtual printer Select AppleTalk or IP Printing (LPR).

5. Set the Media Configuration, Layout, Halftone Handling, and Color Handling options to suit
your workflow, and click Next.
Configure these settings with care because they automatically configure the next dialog box,
the Process Settings dialog box.

6. In the Process Settings dialog box, set options as needed:

a. On the Input Files tab, select options as needed.
b. On the Spot Colors tab, confirm that the settings match the needs of your workflow.
c. On the ICC Settings tab, in the Input File Color Space list, choose the color set that best suits

your region and workflow. To customize or view this color set, click Advanced.
d. In the Simulation Color Space list, choose the color set option that best suits the color space

that you're trying to simulate. To customize or view this color set, click Advanced.
e. In the Proofer Color Space section, ensure the proofer profile is correct. To change the

proofer profile, click Advanced.
f. (Kodak Approval only) On the Screening tab, set the screening and tonal calibration curve

options.
g. On the Output Settings tab, set the options as needed.

7. Click Save.
8. Close the Hot Folders / Virtual Printers dialog box.

Next:
Expose the hot folder or publish the virtual printer.

Publishing an LPR virtual printer on a Mac OS X workstation

After you create a virtual printer, you can add it to any number of workstations, so that operators
at those workstations can submit jobs from their desktop software.

Requirements:
To complete this procedure, you need the IP address of the Proofer Controller and the exact name
of the virtual printer that you want to publish to.
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Some operating systems cannot communicate with hot folders and virtual printers.

1. Perform one of the following actions:

Option Description

For Tiger (Mac OS X 10.4): 1. On the Mac computer, open the Print
Center.

2. In the Printer List dialog box, click Add.
3. In the Printer List dialog box, in the top list,

select IP Printing.
4. In the Printer Type list, select LPD/LPR.

For Leopard (Mac OS X 10.5): 1. On the Mac computer, from the File menu,
select Print.

2. In the Printer List, select Add Printer.
3. In the row of icons, click IP.
4. In the Protocol list, select Line Printer

Daemon - LPD.

2. In the Printer Address box, type the IP address of the Proofer Controller.
3. In the Queue or Queue Name box, type the exact name of the virtual printer that you just

created.
4. In the Printer Model or Print Using list, click Other.
5. In the Choose a File dialog box, locate the directory where you saved the PPD file.

If you installed the PPD file using the directions from this help system, the PPD file should be
located at //Library/Printers/PPDs/Kodak/. The two forward slashes (//) indicate the
highest level of the disk (also called "root"). Make sure that this is where you are looking.

6. Select the PPD file for your proofer, and click Choose.
7. Click Add.
8. From your desktop software program (for example, QuarkXPress), print directly to the virtual

printer that you just configured.

Publishing an IP virtual printer and adding a PPD file on a Windows workstation

After you create a virtual printer, you can add it to any number of workstations so that operators at
those workstations can submit jobs from their desktop software.

Requirements:
● The LPR port exists on the workstation.
● The exact name of the virtual printer that you want to publish to. The name must not contain

spaces.
● A PPD file for the proofer
● The Adobe Universal PostScript Windows Driver Installer 1.0.6, a free download from the

Adobe Web site (http://www.adobe.com/support/downloads/product.jsp?
product=44&platform=Windows)

Note: In this procedure, whenever you are given an option to restart the computer, select restart.
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Some operating systems cannot communicate with hot folders and virtual printers.

1. Start the Adobe Universal PostScript Windows Driver Installer that you downloaded. Click
Next, and then click Accept.

2. Select It is directly connected to your computer (Local Printer), and click Next.
3. In the Local Port Selection dialog box:

a. Select the LPR port for the virtual printer.
b. Click Next.

4. In the Select Printer Model dialog box, click Browse.
5. Locate and select a PPD file for the proofer, and click OK.
6. In the Select Printer Model dialog box, ensure the Matchprint Inkjet proofer is selected, and

click Next.
7. In the Sharing dialog box, perform one of the following actions, and click Next.

To Do this

Keep the virtual printer local Select Not Shared.

Share the virtual printer on the network Select Shared.

8. In the Printer Information dialog box:

a. In the Printer Name box, type the name of the virtual printer.
b. For Would you like to print the test page?, select No.
c. Click Next.

9. In the Setup Information dialog box, click Install.
10. In the Printer Configuration dialog box, select No, and click Next.
11. In the Setup Complete dialog box, clear the Yes, I want to view the ReadMe file check box, and

click Finish. If you are given an option to restart the computer, select restart.
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Publishing an AppleTalk virtual printer on a Mac OS X workstation

After you create a virtual printer, you can add it to any number of workstations so that operators at
those workstations can submit jobs from their desktop software.

Some operating systems cannot communicate with hot folders and virtual printers.

1. Ensure that a PPD file is installed on the workstation where the proofer client software is
installed. If there are already virtual printers on the workstation, then you can assume that a
PPD file is installed.

2. From the Mac OS X desktop, open the Print Center.
3. In the Print Center dialog box, double-click Add.
4. In the Printer List dialog box (first box), choose AppleTalk.
5. In the second box, choose the AppleTalk zone where the proofer resides.
6. In the Name column, choose a virtual printer.
7. In the Printer Model box, click Other.
8. In the Choose a File dialog box, locate the directory where you saved the PPD file.

If you installed the PPD file using the directions from this help system, the PPD file should be
located at //Library/Printers/PPDs/Kodak/. The two forward slashes (//) indicate the
highest level of the disk (also called "root"). Make sure that this is where you are looking.

9. Select the PPD file for your proofer, and click Choose.
10. Click Add.
11. From your desktop software (for example, QuarkXPress), print directly to the virtual printer

that you just configured.

10.2.7 Submitting a file to a hot folder

After a hot folder is set up, you can submit files to the proofer by dragging each file individually
onto the hot folder that is exposed on the workstation.

Requirements: A hot folder exists and is exposed on your workstation.

From your workstation, drag the files to the hot folder.

10.2.8 Submitting files to a virtual printer

If everything is set up correctly, you can submit a job to the proofer via a virtual printer by selecting
Print from desktop software on your workstation.

Requirements: A virtual printer exists and is published.

From your desktop publishing software (for example, QuarkXPress), print to the virtual printer
that you just configured.

10.3 Manually backing up the system
Any time that you change the Controller settings, create a system backup.
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1. In the Proofer Administrator, click the Controller icon, and click the Backup tab.
2. Click Backup.
3. In the Choose Directory to Save dialog box, select a location for the Kodak Proofing Software

backup file, and click Save.

10.4 Kodak RSS client software
The IT technician at the customer site, who is qualified to reconfigure the site’s network and
firewall settings, should set up the Kodak RSS client software. The client software should already
be installed on the Proofer Controller.

The Kodak Remote Support System (RSS) is an infrastructure that is used to connect to and
support Kodak customers’ equipment. RSS provides connectivity management, diagnostic tools,
per-site equipment information, automated support tasks, and basic support management
features. RSS is used to provide remote support.

Note: Kodak Proofing Software 4.2.0 and later includes version 2.2 of Kodak RSS client software.
Version 2.2 of RSS client software automatically updates itself. If necessary, you can download the
most recent version of the RSS client software from eCentral and install it. Go to the eCentral
portal and download the .exe file.

During the setup process, the IT technician contacts a Kodak service representative to register the
RSS client, and tests the RSS connection. The IT technician must have access to e-mail during the
setup process in order to receive a registration file.

For more information, contact a Kodak service representative, or go to the eCentral portal and
download the Kodak Remote Support System—RSS VPN document.
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11 Troubleshooting

11.1 Troubleshooting general network problems
If the new network settings failed, Proofer Finder does not show the proofer that you just installed,
and the Proofer Controller continues to emit the audible voice message Waiting for any
connection to confirm network settings every 10 seconds. There may be a problem with
the IP address and/or subnet mask. Follow these steps:

1. Verify the correct IP address and subnet mask with the network administrator.

2. Disconnect the Proofer Controller from the network.

3. Restart the Proofer Controller to return to the factory DHCP settings.

11.2 Troubleshooting license problems
A license might be rejected for one of the following reasons:

● The text file format is RTF.
● The file contains extra data content.
● The system already had an emergency license installed.
● The text editor cannot distinguish between em and en dashes.

The text file is RTF

If you open the text file using the TextEdit software on a Mac computer, the default file format is
RTF. This format adds additional information that the Proofer Controller cannot read. Change the
file format to plain text.

From the Format menu, select Make Plain Text. Click Save.

The file contains extra data content

If you copy and paste the license key text information from a text or XML file and include any extra
data, the import will fail. The correct data should include only hyphen-separated alphanumeric
data. If any of the data in the string appears to be natural language data, for example a date string,
then you must remove that data.

The system already had an emergency license installed

If you had an emergency license installed on the controller, even if that license is now expired, for
the system to work properly, you must remove that license before installing a new one. You may
experience unexpected problems, such as not being able to enable an existing proofer or start a
service on the controller. The problems are due to the old license still being available on the system.

To remove an old license, go to the License tab in the Proofer Administrator, select the license key
that you want to delete, and click Remove.
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The text editor cannot distinguish between em and en dashes

If the text editor that was used cannot distinguish between em and en dashes, the license key text
file can become corrupt. Replace the dashes in the license key text file with the minus sign on your
keyboard.

11.3 Troubleshooting hot folders

Unable to mount hot folders on a Mac client computer

You need to enable the NETBIOS setting in the Proofer Controller Windows network settings to
enable Samba access to shares on the Proofer Controller.

1. On the Proofer Controller desktop, right-click My Network Places, and click Properties.

2. Right-click Local Area Connection, and click Properties.

3. Click Install.

4. Select Protocol, and click Add.

5. Select NETBIOS Compatible Transport Protocol, and click OK.

6. Restart the Proofer Controller.
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A Proofer client operation on different subnets
Auto discovery of workflow servers is achieved through multicasting. Multicasting travels over
TCP/IP. If the Kodak proofer client software resides on a different subnet than the workflow server,
the following commands must be placed on the router. These instructions are valid only for the
Cisco 2600 and 3600 series routers. For other models, see the user documentation for
multicasting across subnets.

Procedure step Command Purpose

Step 1 Router(config)# interface
ethernet <slot>/<port>

Configure the physical
interface for transmitting
multicast packets.

Step 2 Router(config-if)# ip
address <address>
<subnet-mask>

Assign the IP address and
subnet mask for the
interface.

Step 3 Router(config-if)# ip pim
sparse-dense-mode

PIM should always be
configured for sparse-
dense-mode.

Step 4 Router(config-if)# ip sap
listen

Listen to packets of session
announcement protocol
(SAP).

Step 5 Router(config-if)# ip
igmp join-group <address>

The address in this
command must match the
multicast address (session
target) for the session.

Step 6 Router(config-if)# no
shutdown

Enable the interface.
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